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BRUKER TWO PHOTON MICROSCOPY GUIDE 
Intro: 
This manual is meant to serve as a reference for best practices and to assist with basic 
troubleshooting. It does not replaced hands on training with an experienced user nor does it 
cover every situation/issue you may encounter. If you are uncomfortable with or unsure of 
something, ask for assistance! 
General Rules to follow: 

● Lights must be off and the curtain to the dark box sealed before applying any PMT gain 
or increasing laser power. Conversely make sure to stop scanning and zero everything if 
you have to turn the lights back on or check your sample 

● Always be aware of how much power you are using post objective! Refer to power curve 
posted on the wall. Otherwise you will bleach and/or damage your sample 

● Always book the microscope in advance to avoid overlap and premature shutdowns 
● Before imaging know your excitation/emission wavelengths and set the laser wavelength 

and filter cube accordingly 
 

Section 1(a): Setting up for Imaging: 
1. Turn on tower (Always do this first!) 

 
2. Turn on computer and open Prairie View 
3. Laser ON 
4. Wait for mode lock 
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5. Laser shutter open 
6. DON'T TOUCH IR SHUTTER, NOT FOR YOU 
7. Select wavelength you’ll use for imaging 
8. Wait 20-30 minutes for pockel cell to warm-up 
9. Just before putting your sample under, turn the lamp power on to allow it to briefly warm 

up (~1 min) 

 
 

Section 1(b): Shutting Down: 
1. Always ensure proper shut down as the last user of they day! You can check the 

calendar to see if there are any other bookings 
2. Ensure pockels/PMTs are zeroed (should be already after imaging is finished 
3. Turn off and shutter laser  
4. Exit Prairie View (If you have forgotten Step 3 it should prompt you about it 
5. Ensure all your data is saved/transferred 
6. Shutdown Computer (Always do this first!) 
7. Shut off tower 

 
Section 2: Focusing on your sample 

1. Using the coarse focus knob, bring the objective slightly higher than it will need to be, 
this should be right around the center of the Z range marked by the orange arrows 

Orange tape pictures here 
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2. Fix your sample under the objective, being very careful not to touch or bump the 
objective 

3. Carefully bring the objective slightly closer than the working distance of the objective, 
judging carefully by eye and not allowing the objective to touch the sample 

4. Using a transfer pipette, carefully add DI water between the sample and objective, 
making sure complete coverage and no bubble (Tip: Have the pipette tip just above to tip 
of the objective and allow the water to flow down the side of the objective) 

5. Swap to Binocular focus/1P Illumination 
● Turn on lamp light to lowest power (one notch on the dial) 
● Open turret shutter 
● Pull out plunger gently to slide mirror into place(blocking laser) 
● Swap dichroic to mirror (Open latch,slide gently to desired setting, close latch) 

 

mirror/dichroic here 
 

6. Slowly move objective up and away(Rotate coarse knob away from you) from the 
sample, which should move you toward your focus 

7. While adjusting, monitor the image through the binoculars, looking for your sample to 
come into focus 

8. Once you're happy with what you see, swap back to scanning configuration by: 
● Turn lamp dial to off 
● Close turret shutter 
● Push plunger gently back into place 
● Swap from mirror back to dichroic 

9. Close curtain and seal using the magnetic strips 
10.  TURN OFF LIGHTS AND CLOSE DOOR CURTAIN 
11. If not already done, swap door sign to red/active 

 
Section 3: Normal Scanning 

1. Use Section 2 to prepare for scanning your sample 
2. Double check shutter (Imaging & PMT) under Tools-> Maintenance , both should be set 

to Automatic (PMT default is closed) 
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3. Set PMT to a reasonable value (I prefer 750) in correct Channel (Channel 1 is Red, 

Channel 2 is Green for our scope) 

4.  
5. Start live scan 
6. Slowly (increments of 10) bring up pockels value until you can see your image,  never 

surpass safe power  (consult power curve) even if you don’t see your image. If you are 
not seeing anything, refer to you LUT to see if you are getting any signal, or try moving in 
~10 micron increments up and down  

7. Once you have an image, you can use the manual controller (set to fine adjustment!) or 
the stage control in Prairie View to move in x/y/z to find your ROI.  Always be aware of 
your step size 
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8. Things to consider when imaging: 

● Resolution/FOV/Pixel Size: Higher resolution will result in higher quality images 
but slower frame rates. Make sure your pixel size is smaller enough to resolve 
what you’re imaging 

● Dwell Time: Increases the time spent per pixel. Increases will tend to give you 
more signal at the cost of imaging speed and risk of photobleaching/damage 

● Optical Zoom: Restricts the FOV you scan over while keeping the same 
resolution 

● Frame Averaging: Can increase signal to background at the cost of imaging 
speed.  In-vivo  if you are imaging anything dynamic (Calcium activity/RBC flux) 
you should not be averaging 
 

9. It's good practice to: 
●  Take a single image or your ROI for your notes later, especially if you ever want 

to return to a certain region 
● Stop the live scan if you are not actively adjusting your imaging setting or looking 

for some non-static event. There’s no need to be running the galvos to look at the 
same image. 

● Use the Zero feature of the stage control once in your starting ROI, especially in 
Z so you can track your stage movement  
 
 
 

Section 4: Z series: 
1. Refer to the above sections for setting up your sample and find your ROI. In a Z-series 

your starting ROI should typically be at the top of your sample 
2. Once at the top of your ROI move over to the Z-series tab and set this as the top of your 

Z-series, this will save the Z coordinates as well as the pockels and PMT settings 
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3. IMPORTANT:  Go to Laser/PMT Compensation sub-tab in the Z-series tab and select 

relative instead of none, this will ensure your pockels/PMT will be adjust during the 
Z-series as well as if you use the shortcuts to move to top/middle/bottom of series 

 
4. Move down in Z, typically 50-100 micron steps  in-vivo  (Note this will show Z position to 

be increasing).  As your go deeper, your image will get darker, you can slowly increase 
the pockels/PMT gain to keep your image bright, be careful not to use too much power! 

5. Once you are at your desired depth, make any final tweaks to your pockels/PMT gain 
and set your bottom (Be careful to hit the set button not the move to button!). This will 
save your Z depth and your pockels/PMT at that depth.  Double check you set the 
compensation to relative . You should see a chart on the left that matches pockels/PMT 
gain to depth showing a slow increase in both with Z. 

6. Check your middle! The compensation interpolates between the top and bottom settings 
you selected. Hit the move to middle button to traverse to the middle position. Your 
image brightness should be about as good as the top and bottom. You can use 
pseudocolor to check saturation at all three positions. Once you’re happy you can stop 
live scanning and perform the last steps. 

7. Set your step size 
8. Set your frame averaging 
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9. Double check any other important parameters including resolution, dwell time,etc. You 
can also estimate your total acquisition time as Frame Period * Number of slices (This 
does not include time for averaging and saving which will make the total time longer) 

10. Set your save path 
11. Start Z series- It will automatically traverse to the starting position and set the 

pockel/PMT gain settings you gave it 
12. Once the stack completes use the playback to look over the stack for quality 
13. IMPORTANT:  During playback you will not be able to adjust anything in the software, 

and the pockel and PMT will still be set to imaging values, do not turn on room light until 
you have exited playback and zeroed everything) 

 
Section 5: PSF Measurements 

1. This measurement is done by taking the FWHM of a Z-series for a 1 micron fluorescent 
bead. It will be very similar to Section 4 but with a few additional steps 

2. Set up your bead slide as described in Section 2, when you bring the beads into focus it 
will looks like a bunch of small green dots scattered across the FOV 

3. Begin scanning, Pick a single bead to image, use optical zoom until bead takes up 
almost entire FOV (Tip: Use "Mark stage" and click on bead to center it in the image 
window) 

4. Choose a spot for imaging, using 1 micron steps move up and down to try and find bead 
Z center (Where it appears brightest/largest, I like to zero the Z here) 

5. Define z ranges(top/bottom by adjusting z values to until you can no longer see the 
bead. Note: Top and bottom should be ~5 microns above/below bead center 

6. Set step size 0.3, frame averaging to 1 
7. Start Z series 
8. Check Z-series by observing bead coming into and then completely out of focus 
9. Exit playback  and zero pockels/PMT  
10. Open Fiji 
11. Drag-and-drop .XML file from you Z-series to import stack 
12. Choose appropriate channel(Should only be one anyways)  
13. Move to middle of z  
14. Image -> properties 

○ Adjust voxel depth to z step size 
15. Create line in X across desired point, centered in the bead 
16. Image -> stacks -> dynamic reslice 

○ If this doesn’t work,  Press control H for Orthogonal Slice/View 
17. create line in z center along bead profile 
18. Plugins -> FWHM 
19. Want smooth Gaussian 
20. Want: Less than 5 microns (less than 4 without piezo attached) 

 
Section 6: PLIM: 
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1. Check Filter Set for the Dye you are using, diagrams are posted on the inside of the light 
box 

2. Refer to sections 1-3 for setting up and finding your ROI 
IMPORTANT:  Ptp is fluorescent in the green while Oxphor-2p(PtG) is not, you can use 
the green channel to see PtP easily. With PtG you will either need something else that is 
fluorescent in channel 2 (ie FITC). In both cases bring the LUT almost all the way down 
and be very stingy with power  in-vivo  as exciting the dye creates phototoxicity.  

3. PLIM is very slow, therefore you should use point scans to acquire the data you need 
4. Once you have a reference galvo scanned image of your ROI, change the Acquisition 

Mode Galvo->FLIM (Tip: Always zero your Z before doing this) 
5. Set FLIM mode to acquire phosphorescence data: Tools->FLIM-> Acquire 

Phosphorescence Data 
6. Select Point Scan button on the imaging window and new window should open up 
7. Select your desired points 
8. To scan multiple points in one acquisition (most likely case) drag and highlight the 

desired points in the PLIM window and select create group. Highlight the new group on 
the list. (Note: Moving any current point will cause that point(and only that point) to be 
highlighted for acquisition)  

9. Adjust acquisition parameters 
● Cycles Per Point: Number of times to pulse and measure a single point before 

moving on to the next in the group. Cycles are summed to create a single decay 
curve 

● Repetitions: Number of times to repeat the point scan (either single or group), 
Repetitions are summed as a single measurement and saved to a single .sdt file 
(can be parsed out of necessary though) 

● Iterations: Number of times to repeat scan, saved as individual measurement in 
separate .sdt files 

10.  Set pockels/PMT gain- Rule of thumb is to keep laser power under 10 mW from the 
surface, always try to use as little power as possible while having good SNR in your 
decays. Over exciting will results in significant consumption of local O2 that will confound 
your measurements in addition to phototoxicity 

11. Start Acquisition- If you do not see any decays or poor signal after the first 
repetition/iteration, begin troubleshooting/debugging 

12. Once the acquisition is complete swap back a doing a short galvo scan to double check 
your points are still aligned in your ROI. When you swap back a galvo point scan window 
will pop up, close it before scanning 
 
Troubleshooting questions(Not exhaustive): 

● Are you using the correct wavelength? 
● Has the pockel cell been allowed to heat up? What’s your extinction ratio? Post objective 

power at 0 pockels(background excitation)? 
● Is your filter set correct? 
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● Are you using Channel 1 PMT? Check the PLIM window to make sure Channel 1 is 
active 

● Are you in PLIM mode (FLIM acquisition mode, acquire PLIM under preferences) 
● Can you see the dye sufficiently in fluorescence with appropriate power (Channel 2, Ptp 

ONLY)? 
● Is the dye fresh/prepared correctly? How much did you inject? 
● Is the objective heated to correct temperature? 
● Is the Z stage jumping on you/did your ROI move ( in-vivo )? 
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